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This document describes the new features, product enhancements, and other 
improvements implemented in the Dragonfly and Dragonfly Pro 4.0 software release. 
You should read these release notes carefully before you install this new version.
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New Features
The 4.0 software release for Dragonfly and Dragonfly Pro provides the following new 
features. For information about deep learning enhancements — as well as 
improvements for registering datasets, sampling, creating animations, and other 
changes — see Product Enhancements on page 49.

Official Linux Release
This software release marks the official release of the Linux versions for Dragonfly and 
Dragonfly Pro.

Dragonfly Organizer
Dragonfly’s new Organizer provides an easy way to organize, manage, and share your 
data and analysis results. The Organizer is equipped with drag-and-drop features so 
that you can readily add objects — such as image data, regions of interest, multi-ROIs, 
meshes, screen captures, session files, and more — to a project.

Dragonfly Organizer dialog

With Dragonfly’s new Organizer you can:

• Organize data in a variety of ways, add tags to a project and saved objects for easy 
searching, as well as move, rename, merge, and delete projects.

• Create root folders that can hold multiple project folders.

• Search local drives and remote servers for matching tags and data types, or by date.

• Protect your private data while sharing your public projects with other users.

NOTE The Organizer is a separately licensed feature for Dragonfly. Contact Object Research 
Systems to request pricing for this module and availability.
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Bone Analysis
The Bone Analysis module for Dragonfly 4.0 lets you discover new productivity for your 
bone image analysis needs. With the unique pairing of robust quantification with 
options to map and analyze trabecular anisotropy by orientation, Dragonfly’s Bone 
Analysis module lets you better understand complex metabolic bone diseases to help 
develop new therapies and treatments. The benefits of Bone Analysis include the 
following:

• Computation of common bone morphometric measurements, as described by 
Bouxsein et al. 2010. JBMR 25(7):1468-86, from segmented bone regions that 
provide quantitative descriptions of bone microarchitecture.

• Computation of anisotropy with surface orientation of trabecular bone.

• Mapping of orientation and value — from a mesh and from an ROI — colorized 
according to the orientation of the vectors.

NOTE Bone Analysis is a separately licensed feature for Dragonfly 4.0. Contact Object 
Research Systems to request pricing for this module and availability.

Bone Analysis results

NOTE The Bone Analysis module is a pre-clinical research application designed to facilitate the 
analysis of high-resolution micro–computed tomography (micro-CT) images. You should 
note that currently available micro-CT scanners can achieve an isotropic voxel size of as 
low as a few micrometers, which should be sufficient for investigating structures such as 
mouse trabeculae that have widths of approximately 30 to 50 micrometers. You should 
also note that measurement error will decrease as the ratio of voxel size to object size 
decreases, regardless of scale.

Mapping of trabecular bone thickness Mapping of surface normal anisotropy
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Dragonfly's Bone Analysis module can separately segment and identify cortical and 
trabecular bone in whole-bone specimens. The calculation of common bone 
morphometric measurements from these segmented regions then provide quantitative 
descriptions of bone microarchitecture.

To start an analysis, choose Bone Analysis in the Tools menu. Automated segmented 
routines, cortical and trabecular measurements, as well as mappings of anisotropy, are 
available in the Bone Analysis dialog shown in the following screen capture.

Bone Analysis dialog

Global measurements for segmented cortical and trabecular areas

Abbreviation Measurement Description

Ani.MIL Anisotropy (MIL)* A measurement of the orientation of trabecular architecture that uses the mean 

intercept length (MIL) method.

The MIL method (Whitehouse, 1974; Harrigan and Mann, 1984; Cowin, 1986) uses 

the mean distance between material intersections (bone–marrow interfaces) along 

linear traverses over a range of orientations. Because MIL traverses cross both 

materials, the result is a combined measure that incorporates features of both 

materials.
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* The orientation of trabecular architecture can affect mechanical behavior and is often associated with disease and aging.

** Assessed using direct 3D methods.

Ani.SVD Anisotropy (SVD)* A measurement of the orientation of trabecular architecture that uses the star 

volume distribution (SVD) method (Cruz-Orive et al.,1992; Karlsson & Cruz-Orive, 

1993).

In this method, the distribution is determined by placing a series of points within the 

material of interest, and measuring the lengths of the lines emanating from them in 

various directions until they encounter a boundary. These lines are considered 

infinitesimal cones, with their vertex at the origin and subtending a solid angle as 

they approach the material interface.

TV Total volume Volume of the entire region of interest.

BV Bone volume Volume of the region segmented as bone, calculated in the same manner as TV.

BV/TV Bone volume fraction Ratio of the segmented bone volume to the total volume of the region of interest.

Ct.Th Average cortical thickness** Mean thickness of cortical bone.

Tb.Th Average trabecular thickness** Mean thickness of trabeculae.

Calculated by fitting maximal spheres within the trabecular structure. The diameters 

of the spheres within the bone and the marrow regions provide estimates of Tb.Th 

and Tb.Sp.

Tb.Sp Average trabecular 

separation**

Mean distance between trabeculae.

Ct.Ar Average cortical area Cortical bone area, computed as:

cortical volume (Ct.V) / (number of slices x slice thickness).

Ma.Ar Average marrow area Medullary (or marrow) area.

Tt.Ar Average total area

(cortical + marrow)

Total cross-sectional area inside the periosteal envelope.

Ct.Ar/Tt.Ar Average cortical area fraction Cortical area fraction.

Ps.S3D Periosteal surface (3D) Total surface area of the periosteum, which is the membrane that lines the outer 

surface of all bones, except at the joints of long bones.

Ec.S3D Endocortical surface (3D) Total surface area of the endocortex, which lines the inner surface of all bones.

Ps.Pm Periosteal perimeter Total perimeter of the periosteum.

Ec.Pm Endocortical perimeter Total perimeter of the endocortex.

Abbreviation Measurement Description
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In addition to the global parameters available in the Bone Analysis dialog for volumes, 
areas, and perimeters, per slice measurements in any oblique for segmented cortical 
and trabecular areas are available in the Slice Analysis panel, as shown below.

Slice Analysis panel

Per slice measurements for segmented cortical and trabecular areas

Abbreviation Measurement

Voxel Count Number of voxels contained in the selected region of interest.

lXX Moment of inertia (XX).

lYY Moment of inertia (YY)

lmax Maximum moment of inertia.

lmin Minimum moment of inertia.

J Polar moment of inertia.

Th Mean thickness.

Pm Perimeter.

ROI Area Area of the labeled voxels contained in the selected region of interest.
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Image Stitching
Dragonfly’s powerful new Image Stitcher provides automated and manual alignments to 
precisely combine, or stitch, overlapping 2D or 3D image tiles to create a single high-
resolution image. The coordinates of the tiles in a dataset can be taken directly from a 
configuration file or a grid layout can be selected in the Layout Editor to position the 
tiles in the Stitching workspace. However, the real advantage of Dragonfly's Image 
Stitcher can be found in the automated alignment methods that can correct both 
systematic and non-systematic collection errors.

NOTE The Image Stitcher is a separately licensed feature for Dragonfly and is currently 
available as beta for evaluation purposes. Contact Object Research Systems to request 
pricing for this module and availability.

Right-click the dataset with the image files that you need to stitch in the Data 
Properties and Settings panel and then choose Image Stitching in the pop-up menu to 
open the Stitching contextual window, shown below.

Stitching window

The workspace contains a view of the image tiles arranged in the selected grid layout. 
You can apply different LUTs to your Reference and To Stitch selections, as well as 
outline the images that are contained within the mosaic.

Stitcher panel… Options and controls for automatically and manually aligning 
overlapping 2D and 3D tiled images and stitching the result into a single high-resolution 
image are available in the Stitcher panel. Additional options let you blend overlapping 
regions to create a seamless result, as well as to save a configuration file of the 
coordinates of each image tile in the stitched result.
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Stitcher panel

NOTE You can also translate and rotate the currently selected image tile(s) with the Translate 
and Rotate tools to position image tiles within a mosaic.

Preview windows… Preview windows are available for evaluating the Feature Base and 
Template Matching methods. You can pan, zoom, and customize the window, as well as 
save the figure. The example below illustrates how the best matches within two 
overlapping images are mapped to each other in the Feature Base preview window.

Feature Base preview window
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Stitch 3D Datasets
The new Stitch 3D Datasets feature lets you combine, or stitch, multiple volumetric 
datasets into a single 3D dataset. Select one or more of the datasets you plan to stitch 
in the Data Properties and Settings panel, right-click, and then choose Stitch 3D 
Datasets in the pop-up menu to open the Stitch 3D Datasets dialog, shown below.

Stitch 3D Datasets dialog

The options for stitching let you assign data values to voxels that are out-of-bounds, as 
well as choose a blending method, interpolation type, and resolution for the output. The 
dimensions of the stitched dataset can be constrained to the referenced box.

Create 4D Datasets
You can create a 4D, or time-enabled, dataset from multiple volumetric datasets with 
the new Create 4D Dataset feature. Select one or more of the datasets you plan to 
include in your new 4D dataset, right-click, and then choose Create 4D Dataset in the 
pop-up menu to open the Create 4D Dataset dialog, shown below.

Create 4D Dataset dialog

The options in the Create 4D Dataset dialog let you assign data values to voxels that 
are out-of-bounds, as well as to choose a target resolution for the output. The 
dimensions of the 4D dataset can be constrained to the referenced box.
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Macro Builder
This Dragonfly release adds a new Macro Builder that provides an intuitive, visual way 
to build and edit complex macros or to combine multiple macros for batching. Based on 
Google’s Blockly, which uses interlocking, graphical blocks to represent code concepts 
like variables, logical expressions, iterations, and more, the Macro Builder lets you 
apply programming principles without having to worry about syntax or the intimidation 
of a blinking cursor on the command line.

Macro Builder



16 Release Notes Version 4.0
New Features ‐ Hyper‐Dimensional Imaging

Dragonfly Release Notes

T
M

0
2

1
-A

-0
5

Hyper‐Dimensional Imaging
This release introduces a beta version of Dragonfly’s Hyper-Dimensional Imaging 
module that facilitates the interactive visualization, manipulation, and data analysis of 
multi-dimensional datasets. You can exploit the multi-dimensionality of a dataset — 
with the goal of finding objects, identifying materials, and detecting processes — by 
applying dedicated analytical tools that operate on individual signals.

Choose Tools > HyperChannel Manager on the menu bar to open the Hyper Channel 
tab on the left sidebar.

Visualization of multi‐dimensional image

Plugin Toolbar
The new Plugin Toolbar, shown below, lets you quickly access any of the available 
Dragonfly plugins — such as the Organizer, Bone Analysis, Deep Learning, and Active 
Contour modules, as well as the Infinite Toolbox. The Plugin Toolbar is available by 
default on the left sidebar.

Plugin Toolbar panel
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Feret Diameter Measurements
This software release includes Feret diameter measurements for regions of interest, 
multi-ROIs, and meshes. The measurements of the minimum, mean, and maximum 
Feret diameters are available in the Statistical properties and Information boxes on the 
Data Properties and Settings panel for regions of interest and meshes and in the Object 
Analysis dialog for multi-ROIs.

Feret Diameters Definition
The Feret diameter, or Feret's diameter, is a measure of an object’s size in an arbitrary 
direction. This measurement, which can be defined as the distance between the two 
parallel planes restricting the object perpendicular to that direction, is also sometimes 
called the caliper diameter as it can refer to the measurement of object size with a 
caliper. This measure is often used in the analysis of particle sizes in microscopy, where 
the minimum Feret diameter can be used as the equivalent diameter in a sieve analysis.

Feret diameters computed for a multi‐ROI and filtered in the Measurement Inspector

Min Feret diameter… The shortest distance between any two points along the object 
boundary at an arbitrary angle, also known as minimum caliper diameter.

Mean Feret diameter… The mean value of the Feret diameters over a sufficient number 
of orientations. In Dragonfly, measurements for the mean Feret diameter are taken 
every 5 degrees.

Max Feret diameter… The longest distance between any two points along the object 
boundary at an arbitrary angle, also known as maximum caliper diameter.
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Feret Diameter Measurements for ROIs and Meshes
Feret diameter measurements for ROIs and meshes are available in the Statistical 
properties and Information boxes on the Data Properties and Settings panel, 
respectively. Click the Compute Feret Diameter button in the Statistical properties box 
to compute Feret lengths for a selected region of interest. For meshes, check the Feret 
diameter option in the Information box and then click the Refresh button.

Feret diameter measurements for ROIs and meshes

Feret Diameter Measurements for Multi‐ROIs
Feret diameter measurements for all connected components in a multi-ROI, which can 
examined in table and histogram views, are available as a selectable statistical property 
(see Statistical Properties on page 34).

Feret diameter measurements for multi‐ROIs

Statistical properties for ROIs
Information for meshes
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New Image Filters
The following new filters are available in this software release for processing image data 
and for training deep learning models and classifiers for trainable segmentation.

Artifact Removal
Vertical, horizontal, and arbitrary angle destriping filters are available in Dragonfly 4.0 
for cases in which striped artifacts appear on images. The destriping filters work by 
adding a pattern that interferes with the image to remove stripes, as shown in the 
example below for vertical destriping.

Original data (left) and preview after vertical destriping (right)

NOTE Striping can be caused by opaque or scattering parts of a sample that block part of the 
illumination beam during acquisition.

Comprehensive
This software release features the option to process image data directly in the Image 
Processing toolbox with deep learning models trained for tasks such as denoising, 
segmentation, and image enhancement. You should note that a selection of trained and 
untrained deep learning models are available for download in the Infinite Toolbox 
(https://infinitetoolbox.theobjects.com/). You will need to download at least one model 
before you can access the comprehensive filters.

Original data (left) and after denoising with comprehensive filtering
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Original data (left) and after membrane detection with comprehensive filtering

Original data (left) and after segmentation with comprehensive filtering

You should note that downloaded models, as well as models that you created and 
trained for processing image data, are available in the Options box of the Image 
Processing panel, circled below, when you choose either Deep Learning or Deep 
Learning Denoiser as a comprehensive filter.

Options for Deep Learning filters
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NOTE Deep Learning Denoising requires two inputs — the original data that you need to 
process and a variation of the original data that was processed with a comparable 
smoothing filter, such as a Gaussian or mean filter.

You should also note that the second input must be the same shape as the first.

Segmentation
A number of new image segmentation filters — K-Means and Mini-Batch K-Means — are 
available in this software release to partition images into meaningful regions.

Original data (left) and preview after K‐Means clustering (right)

K‐Means… The K-Means algorithm clusters data by trying to separate samples in n 
groups of equal variance, minimizing a criterion known as the inertia or within-cluster 
sum-of-squares. This algorithm requires the number of clusters to be specified and has 
been used across a large range of application areas. Refer to https://scikit-learn.org/
stable/modules/clustering.html for more information about K-Means clustering.

Mini‐Batch K‐Means… The Mini-Batch K-Means option is a variant of the K-Means 
algorithm which uses mini-batches to reduce computation times, while still attempting 
to optimize the same objective function. Mini-batches are subsets of the input data, 
randomly sampled in each training iteration. In contrast to other algorithms that reduce 
the convergence time of K-Means, Mini-Batch K-Means produces results that are 
generally only slightly inferior to the standard algorithm. Refer to https://scikit-
learn.org/stable/modules/clustering.html for more information about this variation of 
the K-Means clustering.
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Smoothing
Additional filters to help reduce the amount of noise in an image include Anisotropic 
Diffusion, Kuwahara, and Lipschitz.

Anisotropic Diffusion… Is a technique aimed at reducing image noise without removing 
significant parts of the image content, typically edges, lines or other details that are 
important for the interpretation of the image. Anisotropic diffusion is a generalization of 
this diffusion process as it produces a family of parameterized images, but each 
resulting image is a combination between the original image and a filter that depends 
on the local content of the original image. As a consequence, anisotropic diffusion is a 
non-linear and space-variant transformation of the original image. Anisotropic diffusion 
generally preserves the sharpness of edges better than Gaussian blurring.

Original data (left) and after anisotropic diffusion filtering (right) 

Kuwahara… Provides non-linear smoothing for adaptive noise reduction. Most filters 
that are used for smoothing are linear low-pass filters that effectively reduce noise, but 
can also blur out the edges. However, the Kuwahara filter is usually able to apply 
smoothing on the image while preserving its edges.

Lipschitz… Implements a Lipschitz cover of an image that is equivalent to a grayscale 
opening by a cone. The Lipschitz cover can eliminate slowly varying image backgrounds 
by subtraction of the lower Lipschitz cover, which is a top-hat procedure.

Texture Analysis
New texture analysis filters that can characterize the texture of a region by quantifying 
spatial variation in pixel intensities include the following:

Membrane Projections… Enhances membrane-like structures of an image through 
directional filtering.

Thresholding
Additional thresholding filters, which output an image composed of basic classes and 
can be used as masks for segmentation purposes or other image processing tasks, 
include the following:

Adaptive Gaussian… The threshold value is the weighted sum of neighbourhood values 
where weights are a Gaussian window.
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Additional Options for Image Data
This software release includes additional options for working with image data, as 
described below. See Image Stitching on page 12, Stitch 3D Datasets on page 14, and 
Create 4D Datasets on page 14 for information about Dragonfly’s new comprehensive 
image processing plugins.

Add Gaussian Noise
This Dragonfly release provides the option to artificially add Gaussian noise to an 
image. Deliberately corrupting an image with noise may be useful in cases in which you 
need to test the resistance of an image processing operator to noise or to assess the 
performance of various noise filters.

To add Gaussian noise to an image, right-click the required dataset and then choose 
Add Gaussian Noise in the pop-up menu. You can select the level of noise required in 
the Standard Deviation dialog.

Extract ROIs
Available from the Data Properties and Settings pop-up menu, the Extract ROIs item 
automatically creates a new region of interest for each intensity value in the selected 
dataset.

Overwrite Dataset
If required, you can overwrite the values of a dataset with the intersecting values of a 
reference dataset. To overwrite dataset values, right-click the reference dataset and 
then choose Overwrite Dataset in the pop-up menu. The dataset that will be 
overwritten is selectable in the Choose a Dataset to Overwrite dialog, shown below.

Choose a Dataset to Overwrite dialog

NOTE The reference dataset and the dataset to overwrite must be of the same data type — 
UBYTE, SHORT, UINT, or FLOAT. For best results, the datasets should also be within the 
same value range. If required, you can convert or normalize data within a selected range 
with the Dataset Tools.
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New Options for ROIs
A number of new features and options are available in Dragonfly 4.0 for working with 
regions of interest — including graphing, computing volume thicknesses, removing 
unwanted objects, and creating geodesic distance maps. These new features and 
options are described in the following topics.

Graphing for ROIs
The graphing option for regions of interest can provide a ready-made framework for 
performing a wide range of pore network simulations to better understand how porous 
materials behave and how to improve them. For example, to create a graph of a region 
of interest that describes a void space, right-click the ROI in the Data Properties and 
Settings and then choose Create Graph from ROI in the pop-up menu. Graphs of 
regions of interest can be examined in 3D views, as shown below.

Graph of connected and non‐connected porosity

Graph settings, as well as information about the graphed objects, are available on the 
Data Properties and Settings panel and in the Measurement Inspector, as shown in the 
following screen captures.
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Data Properties and Settings panel and Measurement Inspector

You can do the following in the Data Properties and Settings panel and in the 
Measurement Inspector:

• Adjust the radius of spheres representing pores or nodes, as well as their connectors.

• Apply different LUTs to ports and adjust measurement ranges by filtering minimum 
and maximum values in the Measurement Inspector.
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•  Plot histograms of selected measurements, as shown below.

• Export results to a CSV file for additional analysis.

Label Edges of Graph of ROI
This option lets you automatically create a multi-ROI in which the segments contained 
within the selected region of interest are labeled as separate connected components. 
You should note that segments are determined by first skeletonizing the region of 
interest, applying a watershed, and then expanding the ROI and assigning a label to 
each branch.

To label the edges of a selected region of interest, right-click, and then choose Label 
Edges of Graph of ROI in the pop-up menu. The computed multi-ROI will appear as a 
new item in the Data Properties and Settings panel.

Statistical Properties
This software release provides additional statistical properties for selected regions of 
interest.

Interpolated Surface… Provides a more robust method — known as Fast Marching — for 
calculating the surface of a selected region of interest than what was available 
previously with the pixel-wise computation.

Feret diameters… Provides measurements of the minimum, mean, and maximum Feret 
diameters contained in the selected region of interest (see Feret Diameter 
Measurements for ROIs and Meshes on page 18).
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Volume Thickness
Measurements of volume thickness that are based on the sphere-fitting method are 
available in this software release for evaluating structures fully described by a region of 
interest. You should note that one of the key advantages of local thickness 
measurements is that the bias from the 3D orientation of the structure is kept to a 
minimum.

To create a volume thickness map, as shown below, right-click a region of interest and 
then choose Create Volume Thickness Map in the pop-up menu. The new dataset will 
appear in the Data Properties and Settings panel.

Volume thickness of a bone segmentation

You should note that local thickness for a point in solid is defined as the diameter of the 
largest sphere which fulfils two conditions:

• The sphere encloses the point, but the point is not necessarily in the center of the 
sphere.

• The sphere is entirely bounded within the solid surfaces.

Interfacial Surface Computations
This software release offers the opportunity to compute the interfacial surface between 
two regions of interest. For example, between regions of interest describing oil droplets 
and water. You should note that computations are performed in 3D with interpolated 
surfaces that are not limited by pixel-wise methods.
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Selectable Connectivity for Processing
This software release lets you choose the level of connectivity — 6-connected or 26-
connected — that determines how voxels in a region of interest are labeled as separate 
components in generated multi-ROIs and when removing unwanted objects. You should 
note that a set of voxels in an image which are connected to each other is called a 
connected component. Finding all connected components in an image and marking each 
of them with a distinctive label is usually referred to as connected component labeling.

Connectivity is selectable for creating multi-ROIs, and processing islands, as shown in 
the following illustration and explained below. You should note that 18-connected is not 
available as an option in Dragonfly and is included here for reference purposes only.

6‐connected versus 26‐connected

6‐connected… Propagation is done by strictly using the 6 faces adjacent to the current 
seed. This was the default mode in previous Dragonfly versions, and will result in the 
maximum number of labeled objects.

18‐connected… Propagation is done using the 6 faces and 12 edges adjacent to the 
current seed. Will result in fewer connected components than 6-connected. You should 
note that this option is currently not available in Dragonfly.

26‐connected… Propagation is done in all directions, using the 6 faces, 12 edges and 8 
corners adjacent to the current seed. Will result in the fewest connected components, 
but computation times may increase.

Remove Unwanted Objects (Process Islands)
In cases in which you need to refine thresholded segmentation results or isolate objects 
of a certain size, this Dragonfly release provides options to remove small objects from a 
region of interest, as well as to isolate larger objects.
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Right-click a region of interest in the Data Properties and Settings panel and then 
choose Process Islands in the pop-up menu. You can then choose to remove or keep 
objects as described in the following table.

Process Islands options

* See Selectable Connectivity for Processing on page 28 for information about how connected components are computed.

** Objects with an identical voxel count will be considered as unique objects when ranked. 

Description

Remove (6-connected) Removes all objects, as determined by the 6-connected* method, that have a voxel count lower than a 

selected threshold. Voxel counts can be selected in the Minimal Voxel Count dialog, shown below.

Isolate (6-connected) Keeps all objects, as determined by the 6-connected* method, that have a voxel count higher than a 

selected threshold. Voxel counts can be selected in the Maximal Voxel Count dialog, shown below.

Remove (26-connected) Removes all objects, as determined by the 26-connected* method, that have a voxel count lower than a 

selected threshold. Voxel counts can be selected in the Minimal Voxel Count dialog.

Isolate (26-connected) Keeps all objects, as determined by the 26-connected* method, that have a voxel count higher than a 

selected threshold. Voxel counts can be selected in the Maximal Voxel Count dialog.

Remove (6-connected)

nth First Biggest

Removes a selected number of the largest connected components, as determined by the 6-connected* 

method and as ranked by voxel count**. For example, if 5 is selected as the threshold, then the largest 5 

connected components will be removed from the selected region of interest. The number of components 

to remove can be selected in the Remove Biggest Count dialog, shown below.

Isolate (6-connected)

nth First Biggest

Keeps a selected number of the largest connected components, as determined by the 6-connected* 

method and as ranked by voxel count**. For example, if 12 is selected as the threshold, then all 

connected components except for the 12 largest will be removed from the selected region of interest. The 

number of components to retain can be selected in the Isolate Biggest Count dialog, shown below.

Remove (26-connected)

nth First Biggest

Removes a selected number of the largest connected components, as determined by the 26-connected 

method* and as ranked by voxel count**. The number of components to remove can be selected in the 

Remove Biggest Count dialog.

Isolate (26-connected)

nth First Biggest

Keeps a selected number of the largest connected components, as determined by the 26-connected* 

method and as ranked by voxel count**. The number of components to retain can be selected in the 

Isolate Biggest Count dialog.
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Create ROIs Using Neighbor Counts
This new option for regions of interest lets you create a new ROI that contains only 
voxels with an original neighbor count greater than or equal to a selected threshold. 
Thresholds are selectable in the Neighbor Count dialog, shown below. To open the 
dialog, select the required region of interest, right-click, and then choose Create ROI 
Using Neighbor Count in the pop-up menu.

Neighbor Count dialog

NOTE This option can be applied to facilitate the topological analysis of skeletons, for example.

Smoothing for Thickness Mesh Export
In this software release, smoothing is selectable when regions of interest are exported to 
normal and sampled thickness meshes from the ROI Tools panel on the Segment tab.

Export options for regions of interest

Two methods — Laplacian Smoothing and Hamming Windowed Smoothing — are 
available for smoothing in the Export as Thickness Mesh dialog, shown below. The 
number of iterations is also selectable.

Export as Thickness Mesh dialog

Close Inner Holes
This software release includes an additional morphological operation for regions of 
interest that lets you close holes smaller than a thresholded distance.

To close inner holes, as shown in the following illustration, right-click the required 
region of interest and then choose Close Holes Smaller Than in the pop-up menu. The 
threshold distance is selectable in the Threshold dialog.
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Original region of interest (left, in red) and results of closing holes (right, in blue) 

Geodesic Distance Maps
For flow analysis and other applications, this Dragonfly offers the option to create 
geodesic distance maps that compute the shortest path from a seed point that joins all 
points inside a region of interest. As shown in the example below, LUTs can be applied 
to geodesic distance maps, which can be examined in 2D and 3D views and are 
computed using the Fast Marching method.

Geodesic distance map of a pore network

To create a geodesic distance, right-click the region of interest that you need to map 
and then choose Create Geodesic Distance Map in the pop-up menu. You can then 
select the seed point in the Choose a Seed ROI dialog.

NOTE The geodesic distance is the shortest path fully contained within a region that joins two 
points, while the Euclidean distance is the straight line distance.
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Export ROI as Binary
Lets you export a region of interest as a binary file, in which labeled voxels are assigned 
a value of 1 and all other voxels 0.

New Options for Multi‐ROIs
A number of new options are available in Dragonfly 4.0 for working with multi-ROIs. 
These new features are described in the following topics.

Graphing for Multi‐ROIs
The graphing option for multi-ROIs provides an opportunity to investigate the inter-
relationship between connected components. To create a graph of a multi-ROI, right-
click the item in the Data Properties and Settings and then choose Create Graph from 
Connectivity in the pop-up menu. Graphs of multi-ROIs, in which the centroid of 
adjacent objects are linked, can be examined in 3D views as shown below.

Graph of segments

NOTE You can automatically create a multi-ROI of the segments within a region of interest (see 
Label Edges of Graph of ROI on page 26).
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Graph settings, as well as information about the graphed objects, are available on the 
Data Properties and Settings panel and in the Measurement Inspector, as shown in the 
following screen captures.

Data Properties and Settings panel and Measurement Inspector

You can do the following in the Data Properties and Settings panel and in the 
Measurement Inspector:

• Adjust the radius of spheres representing the centroid of each connected component, 
as well as their connectors.

• Apply different LUTs to ports and adjust measurement ranges by filtering minimum 
and maximum values in the Measurement Inspector.
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• Plot histograms of selected measurements, as shown below.

• Export results to a CSV file for additional analysis.

Statistical Properties
This software release includes a number of new statistical properties for analyzing 
multi-ROIs. These properties are available in the Statistical Properties dialog.

Statistical Properties dialog
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New statistical properties for multi‐ROIs

Previous Analyzes
Whenever you need to re-analyze a multi-ROI, you now have the option to include 
previously computed properties in your current analysis. These scalar values are 
available in the Statistical Properties dialog, as shown below. Click Scalar values to 
view and select the properties previously calculated that you want to appear with your 
current analysis.

Statistical Properties dialog

Description

Voxel Count Indicates the total number of voxels contained in each connected component.

Surface Area (interpolated) Provides a more robust method for calculating the surface of the connected components in a multi-ROI 

than was available previously with the pixel-wise method.

Volume/Surface Area 

(interpolated)

Provides a more robust method for calculating the ratio of volume to surface area, as described above.

Surface Area (pixel-wise) Pixel-based method implemented in previous Dragonfly versions for calculating the surface of the 

connected components in a multi-ROI.

Volume/Surface Area

(pixel-wise)

Pixel-based method implemented in previous Dragonfly versions for calculating the ratio of volume to 

surface area, as described above.

Min Feret diameter The shortest distance between any two points along the object boundary at an arbitrary angle, also known 

as the minimum caliper diameter.

Mean Feret diameter The mean value of the Feret diameters over a sufficient number of orientations.

Max Feret diameter The longest distance between any two points along the object boundary at an arbitrary angle, also known 

as the maximum caliper diameter.

Min ortho Feret diameter The shortest distance between any two points along the object boundary that are orthogonal to the 

maximum Feret diameter.

Min ortho/Max Feret 

diameter

The ratio of the minimum orthogonal Feret diameter to the maximum Feret diameter. This measure can 

provide a good indication for the elongation of a particle.
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Import Scalar Values
In some cases, you may want to import the scalar values of a multi-ROI or mesh that 
were exported to a CSV file. As a new feature for Dragonfly 4.0, you can import scalar 
values from either an ORS-formatted CSV file or from a generic CSV file that contains 
the required IDs and corresponding values.

Scalar Value Slots Importer dialog

Extract ROIs
This new feature for Dragonfly 4.0 lets you extract a new region of interest from each 
connected component in the selected multi-ROI. For example, if there are 100 
connected components in the selected multi-ROI, then selecting the Extract ROIs item 
in the Data Properties and Settings panel will result in 100 new regions of interest — 
one for each connected component.

Split Non‐Connected Labels
In cases in which you create a multi-ROI and objects with the same label are not 
connected, you can choose to split those non-connected labels. This can be necessary in 
cases in which you create a multi-ROI from the greylevel values of a dataset. Right-click 
the required multi-ROI and then choose Split Non‐Connected Labels in the pop-up 
menu to split not connected labels.

In the following example, the original multi-ROI with six labeled objects extracted from 
the data values of dataset (using the option New Greylevel Multi‐ROI) is on the left. 
After splitting the non-connected labels of the greylevel multi-ROI, there are 165 
labeled objects, as shown on the right.

Results of splitting non‐connected labels
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Get Merged Label as Multi‐ROI
Lets you create a new multi-ROI with one labeled connected component from a multi-
ROI that contains a number of labels that were merged. For example, through a 
Boolean operation.

New Options for ROIs and Multi‐ROIs
The following new options — Convex Hulls, Remove Touching Objects, and Boolean 
operators for removing and keeping intersecting labels — are available in this software 
release for regions of interest and multi-ROIs.

Convex Hulls
This new option for Dragonfly 4.0 lets you generate convex hulls as filled or outlined 
regions of interest or multi-ROIs, or as meshes. Convex hulls are calculated from the 
minimum set of points that define a polygon containing all of the labeled voxels of a 
region of interest or all of the labeled voxels of each connected component in a multi-
ROI. If you imagine the points as pegs on a board, you can find the convex hull by 
surrounding the pegs by a loop of string and then tightening the string until there is no 
more slack.

In the illustration below, a convex hull as a mesh (in blue) was generated from a region 
of interest describing the outline of a mechanical part.

Convex hull as a mesh

Convex Hull as a Filled ROI or Multi‐ROI… Lets you generate a convex hull as a filled 
region of interest for a selected ROI, or as a series of filled convex hulls for each 
connected component in a selected multi-ROI.

Convex Hull as an Outer Shell ROI or Multi‐ROI)… Lets you generate a convex hull as an 
outlined region of interest for a selected ROI, or as a series of outlined convex hulls for 
each connected component in a selected multi-ROI.

Convex Hull as a Mesh… Lets you generate a convex hull as a mesh for a selected ROI, 
or as a series of convex hulls for each connected component in a selected multi-ROI. 
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You should note that in this case, each connected component in the multi-ROI will be 
generated as an unstructured grid.

Remove Touching Objects
You can automatically remove objects from a selected region of interest or multi-ROI 
that touch another region of interest or multi-ROI by selecting the Remove Objects That 
Touch Another ROI or Multi‐ROI in the Data Properties and Settings pop-up menu item. 
You should note that objects can be defined as groups of labeled voxels that are 
connected.

Boolean Operators
This software release includes two new Boolean operators — Remove Intersected and 
Keep Intersected — for modifying and refining regions of interest and multi-ROIs. 
These options are available in the Boolean operations panel, as shown below.

Boolean operations

Remove Intersected… Automatically removes all labeled components of the initially 
selected item that intersect with the other regions of interest or multi-ROIs selected for 
the operation.

Keep Intersected… Automatically keeps only the labeled components of the initially 
selected item that do not intersect with the other regions of interest or multi-ROIs 
selected for the operation.
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New Options for Meshes
A number of new options, including new mesh settings, smoothing, and a mesh 
subdivider, are available in this Dragonfly release for working with meshes.

Mesh Information
This software release provides additional statistical properties, circled below, for 
selected meshes.

Information for meshes

Feret diameters… Provides measurements for the minimum, mean, and maximum Feret 
diameters contained in the selected mesh (see Feret Diameter Measurements for ROIs 
and Meshes on page 18). Check the Feret diameters option and then click the Refresh 
button to compute the Feret diameters.

Mesh Settings
A new Fill mode — Outlined — is available for rendering meshes in 3D views. In this 
mode, meshes are rendered simultaneously as a solid outline and in wireframe, as 
shown below.

Outlined mesh
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This setting is available on the Data Properties and Settings panel, as shown below.

Mesh settings

Mesh Smoothing
After generating a mesh, it is sometimes necessary to modify that mesh before further 
processing or analysis can begin. In particular, meshes extracted from volumetric image 
data obtained by CT or MRI devices often contain significant amounts of noise. 
Removing noise while preserving the shape of a mesh, as shown in the example below, 
is now an option for Dragonfly 4.0.

Original mesh (left) and smoothed mesh (right)

The options for smoothing a selected mesh are available in the Mesh Smoothing dialog, 
shown below.

Mesh Smoothing panel

The Mesh Smoothing panel offers two filters for smoothing meshes — Laplacian 
Smoothing and Hamming Windowed Smoothing. Outputs of the smoothing operation 
can be a new mesh, so that the original remains unmodified, or a modified mesh.
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Mesh Subdivider
Adding subdivisions to a polygon mesh can useful when you need to add detail in a 
global manner or to create smoother surfaces. Subdividing adds resolution to a mesh by  
increasing the number of its cells. You should note that for each subdivision level 
increase, the number of triangles will increase by approximately a factor of 4. For 
example, if n=2, the number of triangles in the resulting mesh will be 16x the number 
of triangles in the original mesh.

Original and subdivided mesh

The options for subdividing meshes are available in the Mesh Subdivider dialog, shown 
below.

Mesh Subdivider panel

The methods available for subdividing meshes include Linear Subdivision, Loop 
Subdivision, and Butterfly Subdivision filtering. In addition, the number of subdivisions 
requested can be selected. Outputs of the subdivision operation can be a new mesh, so 
that the original remains unmodified, or a modified mesh.

NOTE Refer to https://cmake.org/Wiki/VTK/Examples/CSharp/Meshes/Subdivision for 
information about the implementation of Dragonfly’s Mesh Subdivider.
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Get Non‐Manifold Edges Count
You can now compute non-manifold edge counts to verify that a mesh does not contain 
any edges with more than two faces attached to it. You can use this option to evaluate 
the integrity of a mesh that will be used for 3D printing. 

As shown in the example below, non-manifold topology polygons have a configuration 
that cannot be unfolded into a continuous flat piece. This condition, in which more than 
two faces share an edge, is known as multiply connected geometry.

Non‐manifold edge (in red)

Right-click the mesh you need to analyze and then choose Get Non Manifold Edges 
Count in the pop-up menu. Results are available in the Mesh Information dialog, shown 
below. You should note that a value of 0 indicates that the mesh does not contain any 
non-manifold edges.

Mesh Information dialog

New Options for Scalar Meshes
Histograms, as well as export and import functions, are now available in the Scalar 
information box on the Data Properties and Setting panel, shown below, for selected 
scalar meshes.

Scalar information for meshes

The new options for scalar meshes are described in the following table.

Function Description

Histogram Lets you plot selected scalar values on a histogram. For information about the new 

options available for histograms, such as saving figures and customizing captions, see 

Histograms and Graphs on page 56.

Export Lets you export the scalar values contained in the selected mesh to a CSV file.

Import Lets you import scalar values from a CSV file.

NOTE You can also import scalar values from the Data Properties and Settings panel 

pop-up menu item Import Scalar Values From a CSV File.
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Shape Properties
The basic properties of a selected shape — such as the height, radius, surface, and 
volume of a capsule — are now available in the Data Properties and Settings panel. The 
Basic properties panel is circled below on the following screen capture.

Basic properties for shapes

NOTE Some shapes have additional functions, such as masking for dataset registration (see 
Dataset Registration on page 49).

This software release also provides an Align Centroid With option for shapes. This pop-
up menu item automatically aligns the centroid of a selected shape with the centroid of 
another object. Applicable objects include volumetric image data, regions of interest, 
multi-ROIs, and meshes. Reference objects can be selected in Choose the Object to 
Align With dialog.
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New Options for Boxes
In this software release, boxes can be automatically reduced to the smallest encasing 
rectangle — based on either the maximum Feret diameter of a region of interest or 
mesh or on the minimal box shape. The results of resizing boxes to segmented ROIs is 
illustrated below.

Resized boxes

Take Box Shape from Feret Of
Reduces the selected box to the smallest encasing rectangle — based on the maximum 
Feret diameter and minimum orthogonal Feret diameter of the labeled voxels of a 
region of interest or of an unstructured grid, such as a mesh. You can select the 
required object in the Choose an Object dialog, as shown below.

Choose an Object dialog

Take Minimal Box Shape Of
Reduces the selected box to the smallest or minimal encasing rectangle of a region of 
interest or unstructured grid, such as a mesh. You can select the required object in the 
Choose an Object dialog.

Box shape from Feret of a 
region of interest

Minimal box shape
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New Options for Annotations
As a new option for annotations — such as Rulers, Angles, and Regions — you can 
choose to show or hide associated captions in 2D or 3D views. This option is available in 
the Properties box and is circled below.

Annotation properties

Extract Images from Visual Planes
As a new option for Dragonfly 4.0, you can extract a 2D image that corresponds to the 
oblique or double-oblique angle of a selected visual plane.

As shown in the screen captures below, a single-slice 2D image (on right) was extracted 
from the visual plane displaying the data of the corresponding MPR plane (on left).

Visual plane and extracted dataset
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Gamma Ramp for Window Leveling
Gamma correction, or often simply gamma, is a nonlinear operation used to optimize 
the contrast and brightness in the midtones of an image. The option to control the 
gamma curve, which is a new feature for Dragonfly 4.0, can help you better visualize 
the dynamic range of selected window leveling values as shown in the comparative 
images below.

Original image (left) and the same image with gamma corrected (right)

The gamma curve, as well as adjustment controls, are available in the Window Leveling 
panel, shown below.

Window Leveling panel

Configurable Actions
Additional configurable actions are available for adjusting the window leveling gamma 
value.

Adjust window leveling gamma in any mode… Lets you adjust the gamma curve in any 
mode. For example, when zooming.

Gamma slider… Lets you adjust the applied gamma 
curve. You should note that the local gamma typically 
rises from 1.0 to about 2.0.

Gamma curve… The gamma curve determines how 
tones are displayed by defining the relationship 
between input values and the resulting image 
luminance. The curve is adjustable with the Gamma 
slider.
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Synchronize 3D Views
This software release lets you synchronize the 3D views available in multiple scenes in 
the workspace with the orientation and zoom applied to a reference 3D view. Select the 
Position option in the Scenes Views Synchronizer panel, as shown below, to set the 
selected 3D view as the reference for all other 3D views in the Dragonfly workspace.

Scenes Views Synchronizer for 3D views

Movie Maker
A number of new options for creating animated sequences in the Movie Maker panel, as 
well as other improvements, are available in this software release.

New controls for working on the timeline include the following:

• Set keyframe position… Lets you manually set an exact keyframe position on the 
timeline. To open the Keyframe Time dialog, right-click the required keyframe and 
then choose Set Keyframe Position in the pop-up menu. The keyframe position can 
be selected in the Keyframe Time dialog, shown below.

• Update keyframe without camera… Lets you update all changes made to a keyframe, 
except for those related to the camera — such as zooms or rotations. This option lets 
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you maintain the original position of an object, regardless of any applied camera 
manipulation. For example, after rotating a view to adjust a clip box.

• Loop playback… If selected, lets you preview your animated sequence in a 
continuous loop.

In addition, the following improvements have also been implemented for the Movie 
Maker:

• Easier manipulation of mesh frames.

• When new objects are added to the timeline, they will appear at the relevant 
keyframe and onwards only.

• Better interpolation for regions of interest and multi-ROIs, as well as improved 
performance for animating scalar values.

2D Animations
For 2D animations, this software release provides the option to export 2D animations as 
images to a number of different file formats. Click the Export button on the 2D 
Animation panel, shown below, to export the selected sequence to a series of BMP, GIF, 
JPEG, and TIFF image files or in the EPS file format.

2D Animation panel
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Product Enhancements
This release provides the following product enhancements for Dragonfly 4.0. For 
information about new features, such as the Organizer, Image Stitcher, and the Bone 
Analysis modules, as well newly implemented options for image data, regions of 
interest, and multi-ROIs, see New Features on page 7.

Deep Learning
This software release features a number of enhancements for the initial version of the 
Deep Learning tool that was first introduced in Dragonfly 3.6. These enhancements 
include the following:

• The segment dataset with classifier feature can now use deep learning models.

• Multiple channel inputs, such as RBG, are now supported.

• Implementation of options to check and uncheck parameters such as zoom, range, 
and rotation for data augmentation.

• Elastic deformation on patches with the option to add Gaussian noise.

• Training data statistics are shown for segmentation.

• You can download trained and untrained neural networks from the Infinite Toolbox, as 
well as publish your own neural networks to the Infinite Toolbox.

Dataset Registration
This software release provides additional options for Dragonfly's feature-based 
registration workflows, which can automatically register datasets by applying the 
transformations required to match features between two datasets. These new options, 
circled below, include using masks and scaling.

Dataset Registration dialog
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Fixed Mask
If a fixed mask is selected, calculations for the required transformations will be 
constrained to the 3D region defined by the selected mask. In other words, voxels 
outside the mask will not be considered when the required transformations are 
computed. Fixed masks can be a region of interest or any shape, such as a box or 
sphere, and must overlap with the selected Fixed dataset.

Scaling
The registration options now include independent scaling in the X, Y, and Z dimensions 
in the lattice coordinate system of the selected mobile dataset. The Initial step and 
Smallest step for scaling is selectable, and, in Advanced Mode, you can select the initial 
and smallest steps for each axis.

Refresh
Lets you update the registration score estimate after a change to the registration 
method, fixed mask, or mobile dataset.

Dataset Sampler
This software release adds the option to upsample or downsample data by a selected 
factor. These additional options are circled below on a screen capture of the Dataset 
Sampler panel.

Dataset Sampler panel

Upsample by a factor… Lets you select an upsampling factor that will be applied 
uniformly to the spacing values of the input dataset. For an input spacing size of 3.02 
nm and an upsample factor of 2, the resulting spacing size will be 1.51 nm. Likewise, 
for an input matrix size of 512 x 512 x 256 and an upsample factor of 2, the resulting 
matrix will be 1024 x 1024 x 512.

Downsample by a factor… Lets you select a downsampling factor that will be applied 
uniformly to the spacing values of the input dataset. For an input spacing size of 3.02 
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nm and a downsample factor of 2, the resulting spacing size will be 6.04 nm. Likewise, 
for an input matrix size of 512 x 512 x 256 and a downsample factor of 2, the resulting 
matrix will be 256 x 256 x 128.

Slice Alignment Outputs
In this software release, you can choose to crop the output of an alignment to the 
dimensions of the registration selection box or to the dimensions of a user-defined box. 
This option, circled below, is available in the Output options box at the bottom of the 
Slice Registration dialog

Slice Registration panel

Active Contour
For users who use the Active Contour for segmentation tasks, this software release 
adds the option to set the direction of the path normals to inward or outward. For 
example, in cases in which you need to define a tube-like structure with a hollow center.

The Normals Inward option is circled on the following capture of the Active Contour 
panel.
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Active Contour panel

Connectivity Analysis
This software release features an accelerated connected component analysis compared 
with what was available in previous Dragonfly versions. Connectivity is also selectable 
(see Selectable Connectivity for Processing on page 28).

Updates for the Dataset Properties
A number of changes and updates are available in this software release for the Dataset 
Properties and Settings panel and for modifying dataset properties.

List Items
Two new items have been added the Dataset Properties and Settings panel as the result 
of major new features for Dragonfly 4.0. These are Graphs and Vector Fields.

Dataset Properties and Settings panel

Graphs… Lets you filter the Data Properties and Settings panel list to show only graphs 
(see Graphing for ROIs on page 24 and Graphing for Multi-ROIs on page 32 for 
information about graph objects).

Vector Fields… Lets you filter the list to show only vector fields (see Bone Analysis on 
page 8 for information about vector fields).
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Undo for Applied Changes
In this software release, changes to the position in space or orientation applied to a 
dataset in the Advanced Dataset Properties panel can be undone by clicking the Undo 
button in the Move panel, shown below.

Move panel

Data Units
The data units selected during file import, circled below, are now displayed in the 
Dataset Properties panel and can be edited, if required.

Dataset Properties panel

3D Presets
Applying a 3D preset to selected image data lets you quickly apply grouped 3D settings, 
scene's views properties, and lighting effects to improve the visualization of 3D 
renderings. In this software release, the default 3D presets available in the new drop-
down menu are categorized for specific materials, such as biological samples, concrete, 
plastics, and metals. In addition, you can also create your own 3D presets for particular 
materials or data samples. You should note that you can edit and save user-defined 3D 
presets, but not the default presets.
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3D presets

NOTE User-defined 3D presets can be published to the Infinite Toolbox and shared with the 
Dragonfly user community.

3D Settings
In cases in which a leveled object’s boundaries are indistinct, the new Edge detect 
setting can help visualizations by adding a delineated edge computed from voxel depth 
to a rendering, as shown below.

Edge detect

This new option is available in the 3D settings panel, as shown below.

3D settings

NOTE The Gamma boost option has been removed from the 3D settings panel. However, you 
should note that full gamma adjustments are available in the Window Leveling panel (see 
Gamma Ramp for Window Leveling on page 46).
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Clip and Visual Effects
In Dragonfly 4.0, selected visual effects for clips and shapes now appear in a new 3D 
live effects box, circled below. You can select the properties of a visual effect, as well as 
re-order effects, as previously.

Visual effects

Legends
In this software release, legends can be positioned vertically or horizontally in 2D and 
3D views and their height or width can be adjusted.

Legends in 3D view

• To change the orientation of a legend, right-click the legend and then choose Vertical 
or Horizontal in the pop-up menu. You should note that you can choose a default 
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orientation for legends in the 2D Settings preferences (see 2D Settings Preferences 
on page 66).

• To change the width or height, drag from the start or end point of the legend, as 
shown below.

Histograms and Graphs
A number of additional options are now available for histograms plotted from regions, 
regions of interest, and meshes with scalar information. You can save an image of the 
figure, as well as edit captions and the plotted data range. In addition, you should note 
that these options are also available for intensity profiles and for the results of a slice 
analysis.

Histogram dialog

The new options for histograms and graphs are described in the following table.

New options for histograms and graphs

Description

Save… Saves the figure as a bitmap image, vector graphic, or in the PDF file format. The figure can also 

be saved as raw data or PGF code for LaTeX.
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Slab Thickness Adjustments for 2D Views
In previous Dragonfly versions, the slab thickness of MIPs, mIP, and average intensity 
projections could only be adjusted in the corresponding MPR views of the dataset. This 
software version includes a Slab Thickness dialog, in which a thickness value can be 
entered directly from the view in Slab mode.

Right-click inside the view in Slab mode and then choose Set Slab Thickness in the 
pop-up menu. You can then enter the required slab thickness in the Enter a New Slab 
Thickness dialog, as shown below.

New Slice Thickness dialog

Settings… Lets you edit the captions on the histogram or graph, apply scaling, and set a data range. 

These options are available in the Figure options dialog, shown below.

Description
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NOTE Selected slab thickness values are also now displayed in the associated MPR views, as 
shown below.

Text Annotations for 3D Views
You should note that a new interactive text annotation — that indicates the size of the 
3D view when you are in Orthographic view mode or the distance to the camera pivot 
point (PD) for perspective views — is available in this software release for 3D views. You 
can drag up or down from the text annotation to adjust the zoom factor.

Text annotations for 3D views

Support for RGB Images
This software release offers additional options for importing RBG images. RGB outputs 
are available in the File Import dialog, as shown below.

RGB output options

Output options for RGB images

Description

As three separate channels If selected, all three channels — Red, Green, and Blue — will be loaded 

and each separate channel will be identified as to its originating channel 

in the Data Properties and Settings panel. For example, Blue Imported 
Data.

As one luminance channel If selected, the RGB image will be converted into a single-channel 

luminance representation. In Dragonfly, the conversion of an RGB image 

to a luminance channel is computed as follows:

Luminance = 0.2126*R + 0.7152*B + 0.0722*G

NOTE Refer to https://en.wikipedia.org/wiki/Grayscale for more 

information about luminance conversions.

Orthographic projection Perspective view
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NOTE The above options are not available for RGBA images. For these images, all four 
channels — Alpha, Red, Green, and Blue — will be imported and added automatically to 
the Data Properties and Settings panel.

If required, you can export RGB channels in the BMP, JPEG, PNG, and TIFF file formats. 
Select the three separate channels on the Data Properties and Settings panel — Red, 
Green, and Blue — right-click, and then choose the Export as RGB item in the pop-up 
menu. You can drag channels up and down to match them to a specific output in the 
Export as RGB dialog, as well as replace channels.

Export as RGB dialog

ROI Painter Tools
A number of performance related issues were addressed in this software release. These 
include the following:

• Acceleration of adding and subtracting with the Circular Brush tool when painting on 
very large regions of interest — with or without a defined range.

• Acceleration of adding and subtracting with the Square Brush tool when painting on 
very large regions of interest — with or without a defined range.

Measurement Inspector
A number of issues related to the performance of the Measurement Inspector were 
addressed in this software release. These include the following:

• Quicker response when making range selections.

• Updates for new graph requirements (see Graphing for ROIs on page 24 and Graphing 
for Multi-ROIs on page 32).

As one grayscale channel

(RBG channels are identical)

If selected, one channel will be loaded. You should note that if the Image 

Loader determines that all three channels are not identical after the 

loading, a message box will appear.

Description
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About Menu Items
Information in the Help > About menu item has been categorized by type — Actions, 
Image Filters, Macros, Menu Items, Object Analysis Statistics, and so on.

About submenu items

In addition, information about each item is available in a separate dialog. Double-click 
an item in the About Plugins dialog to view the information available for the selected 
item, as shown below.

About Plugins dialog
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Developer Documentation
The developer documentation for Dragonfly has been updated for version 4.0. Choose 
Help > Dragonfly Developer Documentation on the menu bar to open the 
documentation system.

IMPORTANT NOTE Some architectural changes were implemented in Dragonfly 4.0. 
You may need to update development work in progress accordingly. You should also 
note that citations are now added automatically to user-created plugins and extensions.
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Menu Bar Changes
The following changes and new items for the menu bar are implemented for Dragonfly 
4.0.

File Menu
New items, listed below, and other changes are available for the File menu.

File menu changes

Tools Menu
A number of new items, listed below, and other changes have been implemented for the 
Tools menu.

Tools menu changes

Help Menu
A number of new items, listed below, and other changes have been implemented for the 
Help menu.

Help menu changes

Description

Open the Organizer Opens the Organizer, which provides an easy way to organize, manage, and share your data (see 

Dragonfly Organizer on page 7). 

Description

Bone Analysis Opens the Bone Analysis dialog, which helps you better understand complex metabolic bone diseases 

(see Bone Analysis on page 8).

HyperChannel Manager Opens the Hyper Dimensional tab on the left sidebar (see Hyper-Dimensional Imaging on page 16).

Macro Builder Opens the Macro Builder, which provides an easy way to combine macros for batching (see Macro 

Builder on page 15).

Open All Users Folder in File 

Browser

Automatically opens the Dragonfly directory with the Python All Users Extensions folder in your installed 

file manager. The Python All Users Extensions folder can otherwise be found in ProgramData > ORS > 

Dragonfly.

Open Current User Folder in 

File Browser

Automatically opens the Dragonfly directory with the Python Users Extensions folder in your installed file 

manager. The Python Users Extensions folder can otherwise be found in AppData > Local > ORS > 

Dragonfly.

Description

About Submenu items — Actions, Image Filters, Macros, Menu Items, Object Analysis Statistics, Plugins, 

Property Panels, and Slice Analysis Measurements — have been added to the About item to help you find 

information about Dragonfly plugins easier. In addition, the available information has been augmented 

with attributions, contact information, and versioning (see About Menu Items on page 60).
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Changes to Contextual Menus
The following changes and new items for the contextual menus are implemented for 
Dragonfly 4.0.

Dataset Pop‐Up Menu
A number of new items, listed below, are available for the dataset pop-up menu.

Dataset pop‐up menu changes

* Available for multiple selections only.

Region of Interest Pop‐Up Menu
A number of new items, listed below, and other changes have been implemented for the 
region of interest pop-up menu in this software release.

Region of interest pop‐up menu changes

Description

Image Stitching Lets you precisely combine, or stitch, overlapping 2D or 3D image tiles to create a single high-resolution 

image that is beyond the normal aspect ratio and resolution of a microscope's field of view (see Image 

Stitching on page 12).

Add Gaussian Noise Lets you artificially add Gaussian noise to an image (see Add Gaussian Noise on page 23).

Extract ROIs Automatically creates a new region of interest for each intensity value in the selected dataset (see Extract 

ROIs on page 23).

Overwrite Dataset Overwrites the intersecting values of a selected dataset with the corresponding values of another dataset 

(see Overwrite Dataset on page 23).

Create 4D Dataset Lets you can create a 4D, or time-enabled, dataset from multiple volumetric datasets (see Create 4D 

Datasets on page 14).

Export as RGB* Lets you export selected red, green, and blue channels as image files (see Support for RGB Images on 

page 58).

Stitch 3D Datasets Lets you combine, or merge, multiple volumetric datasets into a single 3D dataset (see Stitch 3D Datasets 

on page 14).

Description

Create Graph from ROI Lets you map pore networks by showing pore throats and porosity connections (see Graphing for ROIs on 

page 24).

Label Edges of Graph of ROI Lets you automatically create a multi-ROI in which the segments contained within the selected region of 

interest are labeled as separate connected components (see Label Edges of Graph of ROI on page 26).

Export ROI as Binary Lets you export a region of interest as a binary file (see Export ROI as Binary on page 32).

New Multi-ROI

(6-connected)

Creates a new multi-ROI in which connectivity is determined strictly using the 6 faces adjacent to the 

current seed (see Selectable Connectivity for Processing on page 28).

NOTE This item was previously named New Connectivity Multi-ROI.

New Multi-ROI

(26-connected)

Creates a new multi-ROI in which connectivity is determined in all directions, using the 6 faces, 12 edges 

and 8 corners adjacent to the current seed (see Selectable Connectivity for Processing on page 28).

Multi-ROI Analysis Replaces the item previously named New Connectivity Multi-ROI Analysis, which was based on 6-

connected propagation.

Process Islands Lets you remove unwanted objects or isolate objects in a region of interest (see Remove Unwanted 

Objects (Process Islands) on page 28).

Close Holes Smaller Than Lets you close holes smaller than a thresholded distance (see Close Inner Holes on page 30).
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Multi‐ROI Pop‐Up Menu
A number of new items, listed below, and other changes have been implemented for the 
multi-ROI pop-up menu.

Multi‐ROI pop‐up menu changes

Create Volume Thickness 

Map

Lets you measure the thickness volume of a region of interest (see Volume Thickness on page 27).

Create Geodesic Distance 

Map

Lets you generate a geodesic distance map that shows the shortest curve between two points along the 

surface of a region of interest (see Geodesic Distance Maps on page 31).

Convex Hull (as a Filled 

ROI)

Lets you generate convex hulls as filled regions of interest (see Convex Hulls on page 37).

Convex Hull (as an Outer 

Shell ROI)

Lets you generate convex hulls as outlined regions of interest (see Convex Hulls on page 37).

Convex Hull (as a Mesh) Lets you generate convex hulls as meshes (see Convex Hulls on page 37).

Remove Objects That Touch 

Another ROI or Multi-ROI

Automatically removes objects from the selected region of interest that touch another ROI or multi-ROI 

(see Remove Touching Objects on page 38). You should note that objects can be defined as groups of 

labeled voxels that are connected. 

Create ROI Using Neighbor 

Count

Creates a new region of interest that only contains voxels with an original neighbor count greater than or 

equal to a selected threshold. See Create ROIs Using Neighbor Counts on page 30

Compute Interfacial Surface Available for multiple ROI selections, automatically computes the interfacial surface between two regions 

of interest (see Interfacial Surface Computations on page 27).

Description

Description

Import Scalar Values from a 

CSV File

Lets you import scalar values contained in a selected CSV file (see Import Scalar Values on page 36).

New Multi-ROI

(6-connected)

Creates a new multi-ROI in which connectivity is determined strictly using the 6 faces adjacent to the 

current seed (see Selectable Connectivity for Processing on page 28).

NOTE This item was previously named New Connectivity Multi-ROI.

New Multi-ROI

(26-connected)

Creates a new multi-ROI in which connectivity is determined in all directions, using the 6 faces, 12 edges 

and 8 corners adjacent to the current seed (see Selectable Connectivity for Processing on page 28).

Create Graph from 

Connectivity

Lets you graph the inter-relationship between connected components (see Graphing for Multi-ROIs on 

page 32).

Convex Hull (as a Multi-ROI, 

Each Label Being Filled)

Lets you generate filled convex hulls for each connected component in a multi-ROI, as a multi-ROI (see 

Convex Hulls ON PAGE 37).

Convex Hull (as a Multi-ROI, 

Each Label as an Outer 

Shell

Lets you generate outlined convex hulls for each connected component in a multi-ROI, as a multi-ROI 

(see Convex Hulls on page 37).

Convex Hull (Each Multi-ROI 

Label as a Mesh

Lets you generate convex hulls as meshes for each connected component in a multi-ROI, as a mesh (see 

Convex Hulls on page 37).

Extract ROIs Lets you extract a region of interest from each connected component in the selected multi-ROI (see 

Extract ROIs on page 36).

Get Merged Label as Multi-

ROI

Lets you create a new multi-ROI with one labeled connected component from a multi-ROI that contains a 

number of labels that were previously merged (see Get Merged Label as Multi-ROI on page 37).

Remove Objects That Touch 

Another ROI or Multi-ROI

Automatically removes objects from the selected multi-ROI that touch another region of interest or multi-

ROI (see Remove Touching Objects on page 38). You should note that objects can be defined as groups 

of labeled voxels that are connected.

Split Non-Connected Labels Lets you a create a multi-ROI in which objects with the same label that are not connected are split (see 

Split Non-Connected Labels on page 36).
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Mesh Pop‐Up Menu
A number of new items, listed below, and other changes have been implemented for the 
pop-up menu for meshes.

Mesh pop‐up menu changes

Shapes Pop‐Up Menu
A number of new items, listed below, are available for the Shapes pop-up menu.

Shapes pop‐up menu changes

* Available for Plane shapes only.

** Available for Box shapes only.

Description

Mesh Smoothing Opens the Mesh Smoothing panel, in which you can smooth meshes with a selected method and number 

of iterations (see Mesh Smoothing on page 40).

Mesh Subdivider Opens the Mesh Subdivider panel, in which you can increase the resolution of the selected mesh by 

dividing its cells into smaller units (see Mesh Subdivider on page 41).

Get Non Manifold Edges 

Count

Lets you compute the number of non-manifold edges in a selected mesh (see Get Non-Manifold Edges 

Count on page 42).

Import Scalar Values from a 

CSV File

Lets you import scalar values contained in a selected CSV file (see New Options for Scalar Meshes on 

page 42).

Description

Extract a One Slice Dataset 

from Visual Plane*

Extracts a 2D image that corresponds to the oblique or double-oblique angle of a selected visual plane 

(see Extract Images from Visual Planes on page 45).

Align with Centroid Lets you automatically align the centroid of a selected shape with the centroid of another object.

Mask ROI Removes all labeled voxels from the selected region of interest that are outside of the shape.

Take Box Shape from Feret 

Of**

Reduces a box to the smallest encasing rectangle based on the maximum Feret diameter of the labeled 

voxels of a selected region of interest or mesh (see Take Box Shape from Feret Of on page 44).

Take Minimal Box Shape 

Of**

Reduces a box to the minimal encasing rectangle based on the labeled voxels of a selected region of 

interest or on the bounding box of a mesh (see Take Minimal Box Shape Of on page 44).
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Preferences Changes
A number of new items, listed below, and other changes have been implemented for the 
setting the application preferences.

Views Preferences
Changes for the Views preferences are indicated in the following table.

Views preferences changes

2D Settings Preferences
Changes for the 2D Settings preferences are indicated in the following table.

2D Settings preferences changes

3D Settings Preferences
Changes for the 3D Settings preferences are indicated in the following table.

3D Settings preferences changes

Autosave Preferences
Changes for the Autosave preferences are indicated in the following table.

Autosave preferences changes

Description

Axis indicator size Lets you choose the size of the Axis indicator that appears onscreen.

Description

Legend initial orientation Lets you choose a default orientation for the legend(s) that appear in the scene views.

Horizontal… If selected, legends will appear horizontally by default.

Vertical… If selected, legends will appear vertically by default.

Description

Cubic interpolation If selected, cubic interpolation will be applied by default to the objects rendered in 3D views.

Description

Objects to include in 

autosave file

New objects introduced in this Dragonfly release — Vector fields and Graphs — have been added to the 

objects list.
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System Requirements Changes
This release supports the base system requirements. Any differences in those 
requirements are noted below.

System requirements changes

Extending Dragonfly
Dragonfly’s Infinite Toolbox, an open exchange platform for the Dragonfly user 
community, lets you submit, browse, and download extensions that implement new 
features and workflows for all of your image processing or analysis needs.

Choose Tools > Infinite Toolbox on the menu bar to open Dragonfly’s Infinite Toolbox.

Requesting New Features
Let us know if you have a suggestion for a new feature, or an idea for an improvement 
to an existing workflow.

Version Changes to system requirements

3.0.0 None.

3.1.0 None.

NOTE Dragonfly 3.1 includes a new Anaconda distribution for Python. You should note that the current 

version of Python accessed by Dragonfly will be updated automatically to version 3.6 when you install this 

new release.

3.5.0 None.

3.6.0 None.

4.0.0 None.

NOTE The Anaconda distribution was changed to version 5.2.0 for this software release. You should also 

note that the current version of Python accessed by Dragonfly will be updated automatically to version 

3.6.5 when you install this new release. In addition, the Anaconda distribution will be installed in the 

ProgramData folder, as shown below, instead of the Program Files directory.

This change was implemented to allow users to update Dragonfly without running in Administrator mode. 

If you are updating a previous installation, the current Anaconda distribution will be deleted from the 

Program Files folder.
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Getting Help
Learning Dragonfly
Just by taking a quick look around www.theobjects.com/dragonfly, you’ll find some 
great free resources, such as our latest instructional videos, recorded webinars, and 
user forums.

Reporting Issues
Dragonfly includes an integrated reporting module that lets you include comments and 
other information along with generated DMP and log files whenever you encounter an 
issue that results in a crash or application freeze.

Send Report to ORS dialog

You should note that you can also report an issue at any time by choosing Help > 
Report an Issue on the menu bar.
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